Brush Up On Your Excel Skills
pay people to do your homework
pay people to do your homeworkWhether you are thinking about
re-entering the workforce or just looking to better organise
your home, Excel is an invaluable tool. This program,
originally created in 1987, allows you to create and
manipulate data spreadsheets. Excel is useful for keeping
track of information, creating reports and exporting graphs.
Typically, an excel spreadsheet is made up of individual cells
arranged in horizontal rows and vertical columns. Within each
cell, you will include a piece of data. That data can then be
viewed and analysed within the larger dataset based on the row
and column it is in.
Excel offers a wide variety of functions, the ability to
perform calculations and enable the easy tracking and storage
of data. Many working and stay-at-home mums rely on Excel to
keep their personal, family and professional lives in order.
Whether you want to streamline how your home runs from day-today or seek out formal or informal employment, brushing up on
your Excel skills is a sure-fire way to get ahead.
There are many ways in which you can use Excel. For many stayat-home mums, Excel makes organising the day-to-day tasks of
life significantly easier. Excel can be helpful for keeping
track of daily expenses, such as bill payments, shopping
expenditures or income. It can also help sort daily tasks –
for example, by creating a chore chart for the children (or
the partner!). It can even help with planning for an upcoming
holiday or school field trip, as you can easily budget and
plan within the program. Excel can also be a useful tool for
storing and searching information, such as recipes, books or
shopping lists. Regardless of your specific needs, Excel’s
adaptability and multiple functions will ensure it fits you
and your family’s needs.

Outside the home, Excel can be a useful tool for stay-at-home
mums thinking about re-entering the workforce, whether
formally or informally. Nowadays, many employers expect
employees to be proficient in computer programs, such as
Excel. Regardless of the specific industry, knowledge of Excel
will always be helpful. For stay-at-home mums considering reentering the workforce informally, Excel can be a valuable
tool to help grow a home business or personal brand. Many
mummy bloggers use Excel to track viewers, blog posts or
advertising expenditures. Excel is also helpful for keeping
track of sales of products, whether that is a homemade product
or something like Tupperware or makeup.
For any mum, Excel is a useful and necessary skill. While it
may seem daunting at first, there are numerous ways you can
strengthen your existing Excel skills and develop new ones.
This article outlines some of the key features of Excel all
mums should be familiar with, as well as how to get the most
from using them.

Excel Basics
Even if you’re familiar with Excel, it can still be helpful to
review the basics. Although you may be comfortable creating an
Excel spreadsheet, make sure that you are creating your Excel
spreadsheet with the right formatting for your needs. Tips for
formatting are to pick one font and stick to it. This will
help your spreadsheet to look neater and more uniform. Also,
consider using italicised or bolded fonts to identify column
and row headings or subheadings. You may also manipulate the
size of your font to identify a title, heading or subheading.
Typically, the larger the font the more important the
information is perceived to be and vice versa. For example,
you wouldn’t want the title of your spreadsheet to be smaller
than the data. Ensuring your spreadsheet has proper formatting
will make it easier to navigate and ensure that it looks
polished once it is finished.

Excel Shortcuts
Now that you are comfortable creating a spreadsheet, the next
thing you should learn is the program’s shortcuts. Learning
shortcuts will allow you to navigate Excel easier and faster,
saving time as you use the program. For busy stay-at-home
mums, these shortcuts can help save critical time when using
Excel. Many shortcuts can be used through the keyboard. For
example, hold down the ‘Control’ and ‘C’ keys simultaneously
to copy text, numbers or images. To paste text, numbers or
images, hold down the ‘Control’ and ‘V’ keys simultaneously.
If you’ve made a mistake – don’t fret. You can easily undo
your last action by simultaneously holding the ‘Control’ and
‘Z’ keys. To automatically insert the current date into a
cell, hold down ‘Control’ and ‘:’ to make it appear.
Shortcuts can also be used to navigate your Excel spreadsheet.
For example, holding down ‘Control’ and ‘+’ will select the
current region; holding down ‘Control’ and ‘Space’ will select
the current column; and holding down ‘Shift’ and ‘Space’ will
select the current row. You can also use shortcuts to hide
parts of your Excel spreadsheet. Use ‘Control’ and ‘0’ to hide
the current column and use ‘Control’ and ‘9’ to hide the
current row.
You can also use a shortcut to search your excel spreadsheet,
which is useful to find specific information. For example,
imagine you had an excel sheet of all your daily family
expenses and you wanted to find out how much your family spent
on a particular day. You can hold down simultaneously the
‘Control’ and ‘F’ buttons to open a search bar in the upperright corner of your computer screen. In that bar, type the
date you are looking for and click ‘Enter’. You will
automatically be taken to that date within your excel sheet.
This function is also helpful to locate repeat information.
For example, imagine you wanted to search the same Excel
spreadsheet for any time your family made a purchase related

to the groceries. Hold down both ‘Control’ and ‘F’, then type
into the search bar ‘groceries’ and click ‘Enter’.
Automatically, every use of the word ‘groceries’ will be
highlighted in the spreadsheet. By clicking enter, your
computer screen will automatically jump from one use of the
word to the next. In that way, you can easily navigate to see
any time that word is used within your spreadsheet.

Filtering Results
Another way to easily search your Excel spreadsheet is to
learn how to filter your results. Excel offers an Auto filter
feature, which will quickly and easily filter information for
you. To use this function, go to the top of your computer
screen and click Data > Filter. You will then be presented
with the option to click on options which will automatically
filter your spreadsheet by the information you select.

AutoCorrect & AutoFill
To save even more time while using Excel, you must also learn
how to use the AutoCorrect and AutoFill functions. AutoCorrect
is a feature which will automatically identify and correct
misspelled words and grammar errors. Words that are flagged by
AutoCorrect will appear on your computer screen as underlined
in red. To fix a flagged word, right-click on it. You will
then be presented with options of suggested words or a
suggested grammatical fix. Simply click on the correct option
and it will automatically be updated. AutoFill is another tool
that will save you time while using Excel. To use AutoFill,
highlight the cell with the data in and the cells next to or
underneath it where you want the new data to appear, navigate
to the Home tab and in the Editing section click on Fill, then
Series. This will allow series, such as a numbered list or a
list of dates, to fill-in automatically.
When creating an excel spreadsheet, you may want to include

information from a website. For example, if you are a mummy
blogger, you may want to convert information about your blog’s
views into an Excel spreadsheet. To import data from a
website, scroll to the top of your computer screen and click
Data>From Web. This will open a New Web Query display window
in which you can type or paste an online URL. Copy and paste
the URL of the website from which you wish to import data into
the display window, then click Import. This will automatically
import the data from the website into an Excel spreadsheet.

Manipulating & Exporting
Once you’ve created your Excel spreadsheet and understood the
basic commands of Excel, there are many ways in which you can
manipulate it or export the data within it. One way you can do
this is by creating a chart. There are numerous types of
charts you can make in Excel, including column charts, line
graphs, pie charts, bar graphs, area graphs and surface
graphs. The type of chart you use will depend on the type of
data you are working with and how you want it to be displayed.
To create a chart, you will first select the data you want
included in your chart. To do this, click and drag across the
cells you want until they appear shaded. Next, go to the top
of your computer screen and click Insert, then go to the
Charts section and choose your preferred chart. Automatically,
the chart will be created and inserted into your Excel
spreadsheet. From there, you can change the layout, style and
location of the chart. If you’d like to change the chart’s
title, simply double-click the placeholder title and type in
your new title.
Another helpful tool for analysing your Excel spreadsheet’s
data is the Subtotals command. Image once again that you had a
spreadsheet of your family’s expenses each day. Let’s say you
want to find out how much your family spent within one
particular month. Rather than adding up each of those daily
expenses, you can use the Subtotal command. To do so, select

the cells you wish to add, then go to the top of your computer
screen and click Data>Outline section>Subtotal. This will
automatically add up the sums within those selected cells.
In addition to using the pre-set Excel commands, you can also
create your own formulas to search and format your data. These
cells can help save time by completing addition, subtraction,
multiplication or division for you automatically. To create a
formula, begin typing in the cell in which you want the answer
to your formula to appear. All formulas will begin with the
equals sign (=). Then, type the mathematical formula you want
Excel to calculate, making sure you are identifying the
specific cells you want the formula to calculate with. For
example, if you wanted to know the difference between cell A1
and cell C1, you would write =A1-C1. Once the formula is
written, click enter. The answer will appear in the cell
automatically. When writing a formula, the plus sign (+)
represents addition, the minus sign (-) represents
subtraction, the asterisk (*) represents multiplication, the
slash (/) represents division and the caret (^) represents an
exponent.
Once you have created your Excel spreadsheet, you may want to
save a copy for yourself or share it with someone else. If you
would like your spreadsheet to look more polished and to not
be available to change or edit, then you should export it as a
PDF. Exporting an Excel spreadsheet as a PDF will also hide
any formulas you may have used, instead showing only your
data. To do this, go to the top of your computer screen and
click File>Save As. Once the window opens to save, click ‘File
type’ and select PDF. This will automatically export your
excel spreadsheet as a PDF.
Brushing up on your Excel skills will allow you to take
advantage of all the functions and tools Excel has to offer.
Whether you are working or staying at home, Excel makes the
tracking, storing and calculating of data easier and faster.
This can help to track family expenses, a budget for an

upcoming holiday or schedule children’s after school
activities. Excel also is a valuable skill to add on to your
CV, as well as an asset in any professional setting. By
strengthening your Excel skills through the tips and tricks in
this article, you can use Excel to organise and streamline
your personal, family and professional life.

Your Step-by-Step Guide on
How to Start a Career in
Fitness
Health awareness is on the rise in England, and British
residents enjoy more fitness choices than ever before. Fitness
not only reduces risks of sickness and injury, it imparts a
sense of wellbeing to our everyday lives and keeps us happy.
Regular fitness activities also help alleviate depression and
anxiety and it also aids healthy weight loss. Overall, a
regular fitness regime helps us live a longer, stronger and
healthier life.
With the impressive number of interesting career options
available in the fitness industry, it’s time to decide on the
one that best suits your abilities and talents. Compared to
say, 20 years back, careers in fitness are well-defined and
simpler to pursue than before. The good news is that the
fitness industry in the UK offers an abundance of career
opportunities for diverse personalities, skill sets and
aspirations. What used to be regarded as a hobby or pastime is
now considered as a full-fledged employment option. Nowadays,
full-time and part-time jobs in the fitness industry are no
longer scarce, you can avail of excellent opportunities at the

local, regional or even national level. This is a promising
time to enter fitness either as a trainer, instructor (for
individuals or groups) or specialise in the business side of
fitness.
This leads to an interesting line of thought: have you
considered the idea of starting a career in fitness?
As a mum returning to work, a career in fitness may be just
the right choice for you. A career in the field of fitness is
not only an exciting option, it comes with a range of
impressive benefits. However, with the myriad choices
available in the field, it can be daunting to know how to
begin or how to navigate the overwhelming options that exist
today. Should you consider narrowing down the possibilities or
keep your mind open to diverse options? This article will
describe how to kick-start a career in the field of fitness.

Let’s begin with a brief overview of why you should consider a
career in fitness. Each person pursues a career in fitness for
different reasons. Some are driven by their wish to help
others, others decide to start a career in fitness because a

motivating life experience may have instilled an appreciation
of fitness (perhaps a personal experience of sickness or
injury). In addition, fitness careers are slated to
demonstrate dramatic growth and expansion over the next twenty
years. Besides, this is one market that will not lose jobs to
overseas markets; no customer will be willing to fly overseas
just to see a personal trainer.

What
are
the
benefits
of
fulfilling career in fitness?

a

Firstly, you are making a crucial difference to the lives of
people by helping them become fitter, healthier and stronger.
Many of us look forward to the time that we attend a Pilates
or aerobics class before or after a hard day. Fitness makes
everyone feel better about themselves so you can look forward
to an exciting new day every day. A career in fitness
necessarily involves face-to-face contact with people and this
way, you get to meet new people all the time.
You are also likely to enjoy more time to yourself during the
day as most of your fitness sessions will be before and after
work. You can look forward to completing other chores, looking
after young children, etc. One of the best perks of becoming a
fitness instructor is that you get to be in great physical
shape too. This is especially true when you train groups. In
addition, many well-reputed gyms and clubs offer exclusive
deals and discounts to their staff on merchandise and
services, etc.; you’ll get to enjoy the perks.
If you read through the following checklist and most of the
answers are ‘yes’, you are probably a good fit for the fitness
industry:
You have a strong desire to help others (social
orientation)
You love planning workout routines and schedules

You read articles, blog posts and magazines on fitness
Your family members and friends often ask you for advice
regarding fitness
Routine 9 to 5 jobs do not motivate or interest you
You enjoy making new friends and possess excellent
communication skills (communication skills can always be
polished up)
You love spending all your free time exercising or at
the gym

What does
Involve?

a

Career

in

Fitness

Once you have identified your interest in the field of
fitness, it’s time to understand what the job entails.
According to popular belief, a fitness instructor or trainer
is often synonymous with a drill sergeant who comes across as
intimidating. However, this couldn’t be further from the
truth. Successful fitness instructors are pleasant,
communicative people with a friendly disposition. You also
need a good working knowledge of anatomy, physiology and
psychology combined with the basics of business (if you intend
to freelance or open your own business). In fact, you should
devote the same time and attention in planning your career in
fitness as you would to any conventional occupation like
banking or IT.
You may have to design exercise programmes that will
potentially help your clients achieve their goals. Fitness
trainers also help them adhere to healthy lifestyles and
incorporate mindful eating techniques. Starting a career in
the intensely competitive fitness industry may seem
challenging at first, but once you collect a regular set of
clientele, you will find it financially and personally
rewarding. Collecting a set of regulars (whether in a club,
gym or visiting clients in their homes) takes a little time as

you need to establish your credentials and credibility.
However, remember that in the field of fitness, word-of-mouth
recommendations play a crucial role. Once people begin to see
that your clients are starting to looked more toned, stronger
and fitter, you are likely to enjoy larger clientele.
For example, you may wish to ask yourself if you want to work
for a large or small club or gym or work on a freelance basis.
The answer to this question may be related to your own goals
and vision. Working for a large or reputed company will
provide long-term security, opportunities for promotion and
growth. On the other hand, smaller companies will offer
improved opportunities to learn the ropes and open your own
business someday. Some may enjoy the peace of mind and
security that comes with a regular fitness job while others
may prefer taking a more entrepreneurial approach.
You not only need to ponder over what you want from your
career in fitness, but also how you plan to reach there. As
you start, the jobs that you accept along the way may act as
stepping stones to the job that you ultimately want. It’s
important to have a clear picture of how you want your career
to shape up; keep in mind that it will not all happen in a
day. But enjoy the journey to your ultimate destination,
invest energy and enthusiasm and cherish your job – people
will always recognise that. If you pursue your ambitions with
passion and keep a close watch your career trajectory, your
dreams will certainly transform into reality.
Consider the pluses and minuses of the following options
before you actually go to work:

Going back to college
The obvious positive is that you will learn about biology,
anatomy and physiology from reputed sources and you will earn
a qualification which lends authenticity to your credentials.
The negatives include the fact that this takes quite some time

(perhaps a minimum of two years) and you may have to spend
hundreds of pounds towards the certification. Lastly, formal
and classroom education does not always prepare you for reallife training of people physically.

Obtaining certification
Certification again will help you gain knowledge and
credibility and, in addition, it will cost less than a
qualification from a college. Negatives would include the
facts that it is often challenging to decide on reliability
and authenticity. Also, being faster to obtain than a college
qualification, it does not impart as much knowledge.
A good way is to start working in fitness and perhaps study a
little at the same time at your own pace so that you are able
to relate the knowledge to your ongoing experience. The
earlier you can gain some experience and put it down on your
CV, the better it is for future job prospects.
However, although many of us may secretly yearn to start a
career in fitness, we may have no idea how to go about it.
There is not just one single path to starting a career in
fitness, so let’s explore the different career options. Once
you understand what each one entails, you can decide to go
with the one that resonates with your personal objectives.
Further details about different types of fitness career option
help make the selection process a more informed one.

Gym Assistant
If you are returning to work after a gap and want to get a
foot in the door, try starting out as a gym assistant. Most
gyms are extremely busy and need extra help. Although it’s
basically a customer service oriented role, you can still get
the benefit of gaining fitness training experience. In fact,
you can look forward to learning several things while
performing your duties.

You will learn about the best and safe gym practices
Help patrons use gym equipment and encourage fitness
practices; specific knowledge of muscle groups targeted
by each machine
Ensure that gym rules and regulations are maintained
Adjust each machine to the requirements of individual
patrons
Act as first point of contact for prospective patrons;
explaining fitness packages, timings and rates, etc.
Provide basic assistance to patrons with regard to
shoulder and chest presses, squats and lifts (incorrect
techniques can result in injury)
Oversee maintenance of gym equipment and ensure that
they are all in good working order (this helps you learn
a lot about the way gym equipment works)
Maintenance of cleanliness and hygiene standards
Supervising stock control and storage; ordering stocks
The following skill sets are useful in order to become a gym
assistant:
Good communication and interpersonal skills
Ability to work under minimal supervision
Organisational and planning skills
You may be required to work weekends or evening hours when the
gym is busy. You may also be required to obtain CPR/first aid
certification. This may not be the job that you ultimately
want to be doing, but it will help to immediately put you on
the fitness scene and get updated with exercises, programmes
and so on. It will also help you become familiar with gym
equipment, fitness machines and so on.

Personal Training
Personal training is one of the most sought after jobs because
of the benefits and flexibility associated with it. Moreover,
you can work as a personal fitness trainer in a club, gym or

through a reputed fitness company. In addition, you can
consider freelancing as a fitness trainer and establish your
own hours and pay. Being a full time trainer is not only a
viable option, it is also one of the most competitive fields
to break into. However, regardless of whether you are employed
or independent, you may eventually want to consider
specialising in training a specific group of clients or
developing your own fitness programme. For example, you may
wish to focus on beginners, older adults or women.
If you’ve obtained personal trainer certification, then you
may wish to first gain experience, contacts and skills as an
employee at a gym or club before branching off on your own.
Working as a personal trainer with a company will also provide
job security and a predictable (but reliable) salary. As you
learn the ropes, you can focus on being a personal trainer
instead of having to worry about other aspects of the business
such as administration, advertising and public relations, etc.
Challenges of working as a personal trainer with a company
include being obliged to cater to a diverse set of clientele
(as opposed to working with specific groups) and also working
at fixed hours or timings. If you become popular and wellknown, you are likely to earn much more as an independent
trainer but this takes time.
Aspiring to work as an independent trainer comes with its own
set of benefits and challenges. Benefits include the potential
to earn a higher income (you can enjoy your profit margins
instead of giving over a sizeable percentage to your employer)
and being your own boss. You are likely to enjoy increased
flexibility with regard to hours and days, etc. You also have
the professional freedom to develop your own fitness routines
and programmes geared towards the requirements of your
clients. Challenges include added responsibility of handling
other aspects of the business such as billing, accounts,
marketing, administration, buying equipment and so on. You may
also have to rent space at a gym or club to conduct training

sessions. You may be a very good fitness trainer but it also
pays to develop business development and marketing skills.

In addition, working as a personal trainer involves one-to-one
interaction and this means understanding your client’s fitness
goals and physical limits. The only factor to bear in mind is
that it takes a lot of job experience (with a company or gym)
and credibility to be able to gain a foothold as a personal
trainer. Once you’ve gained the experience and reputation, you
can earn thousands of pounds training clients personally.

Group Trainer
If you plan to return to work as a fitness trainer, becoming a
group trainer is a good way to do it. The field of group
fitness training is less competitive compared to personal
training and it’s an excellent way to learn the ropes. In
fact, you can expect to be hired as group instructor if you
are capable and tuned in to the fitness demands in your local
area. You also have the option of striking out on your own and
training different groups in the outdoors (in parks, for
example), church halls or even in your home. You can work
part-time in a company and freelance at the same time (say, in
the evenings). This is an excellent way of gaining ongoing
experience as well as becoming entrepreneurial at the same
time. At one time, choreographed aerobics classes, for
instance, were the rage, and fitness instructors had to spend
time planning workouts. Nowadays, there are diverse choices

available: you can either specialise in choreographed aerobic
workouts (if you are inclined towards rhythm and dance
movements, go for it by all means), or athletic nonchoreographed workouts where you lead the class. This is
usually conducted without music.
Every time you teach a class, you are promoting your fitness
training skills to a group of enthusiastic and receptive
customers. As a matter of fact, many famous personal trainers
and directors first made their name by training groups. By
keeping your ultimate aspiration in mind, you can strive to
build career momentum by working as a group fitness trainer
and working on other fitness endeavours at the same time. This
will help you gain comprehensive experience while enhancing
your skill set at the same time. The main benefit is becoming
a group trainer puts you directly in front of prospective
clients. Moreover, group training is fun and collaborative.
Challenges include the fact that it is difficult to develop
specialised training programmes for a diverse group of clients
unless you are training special groups. Also, this can be
physically exhausting and it may not be possible to train
groups day-in and day-out; you may end up over-straining
yourself. Hence, group training may not be the right choice
for a long-term career but it can serve as an excellent
stepping stone to a full-fledged career as a fitness trainer
or as a part-time vocation.

Fitness Management
With gyms and clubs mushrooming virtually everywhere, along
with training, there is a real, active need for efficient
management of the business. Some of us may be more interested
in working behind the scenes ensuring smooth operation of
fitness businesses rather than training patrons throughout the
week. At the same time, you will enjoy a ringside view of the
fitness business as you will be actively involved in
organising, planning and coordinating schedules. Your job will

be ‘on the field’ as you manage administrative and business
aspects of the business. In fact, fitness programming and
management can be a regular, meaningful and lucrative
employment for those who are passionate about the behind-thescenes action in the fitness industry. You can expect regular
pay cheques, perks and benefits (bigger companies will offer
medical and dental benefits).
While there a few professionals who work as independent
management consultants, this profile is usually associated
with being an employee. With the rising number of gyms,
franchises, equipment companies and clubs, managerial
positions in fitness companies are becoming increasingly
popular as a career option. Over time and after gaining the
requisite experience, you can expect significant growth in
your career and aspire to more senior posts with greater
responsibilities and attractive remuneration. Some challenges
of becoming a fitness management professional include the
ability to multi-task under pressure and juggle multiple
responsibilities with efficiency and tact. You may feel
overwhelmed at times until you are familiar with the duties
and parameters of the job. The duties of a fitness manager can
be summarised as below:
Meeting target revenues by promotional activities and
marketing
Recruitment and training of staff for group trainer and
personal trainer roles
Ensuring that high standards of hygiene and cleanliness
are maintained
Interaction with individuals as well as corporate
clients and ensuring satisfactory client experience
Managing supplies, stocks and equipment and coordinating
with equipment suppliers and manufacturers for
maintenance
Preparation and maintenance of daily records, finance
management and report generation

Coordinating schedules and ensuring maximum utilisation
of resources
Conflict resolution and staff management
In the early stages of your career, you can hope to earn
anywhere between £17,000 and £28,000. As you gain experience
and upgrade your skills, you can expect to earn anywhere
between £35,000 and £60,000 (or even more for large
companies). The job usually involves very little travel (so
you need not be nervous about disrupting your family life) and
you can also enjoy the prospect of bonuses, perks and
pensions. While many companies will provide on-the-job
experience and structured training, many times, your ability
to learn will depend on initiative.
Many British organisations offer certifications and diplomas
for fitness manager training including CIMSPA (Chartered
Institute for the Management of Sport and Physical Activity)
and BASES (British Association of Sport and Exercise
Sciences).

Health and Wellness Coach
A health and wellness coach helps clients achieve health goals
which may or may not have an athletic aspect associated with
it. However, health and wellness coaches also fit into gym or
club work settings easily and are often sought-after
professionals. A health and wellness coach provides
information to clients on ways to achieve health (including
weight loss) and wellness through diet as well as exercise.
The duties and responsibilities of a health and wellness coach
will involve:
Encourage habits that are conducive to a healthier life
and higher fitness levels
Develop and implement seminars and talks on health and
wellness onsite at gyms, clubs, offices, etc.
You will work with clients to explore their lifestyles,

habits and environments in order to promote positive
choices
Communicate and motivate clients to make changes to
their lives
As a health and wellness coach, you may work fulltime for a
company, part-time or as an independent contractor.
Jobs increasingly involve working on the computer and sitting
down in one place. Household chores can be conveniently
completed with the help of equipment like washing machines,
dishwashers and mixers. As a result, physical activity has
reduced since earlier days where we walked long distances to
get somewhere or washed clothes or did other physical work
that kept us automatically fit and strong. However, the good
thing is that there is increasing awareness regarding the
importance of fitness. People of all ages and income groups
are now beginning to realise that they have to invest special
effort into toning and strengthening their body. Moreover,
different people prefer different forms of exercise according
to their inclination and interests. Some may prefer brisk
walking or jogging in the open air while others may prefer an
intense gym workout, aerobics, Pilates or yoga.
The important thing to keep in mind is that fitness is not
about body aesthetics or weight loss; these are additional
advantages. It’s more about toning and strengthening your body
for a better quality of life. Fitness awareness is here to
stay and the number of people actively pursuing different
modes of fitness is increasing every day. Hence, fitness
trainers and instructors are in demand.
If fitness is your passion, then pursuing a career in fitness
can help add value, meaning and purpose to your life as well
as to other people’s lives. Whether it’s personal training or
group fitness training or any other career in fitness, you can
enjoy a long and successful innings if you’re willing to
invest the effort and dedication. The fitness industry in the

UK is booming and the sector is generating revenues in
millions of pounds. This can promise to be a flourishing
career if you adopt the right mindset and attitude.

Looking to Enhance your Skill
Set and Jump Start your
Career? Online Courses offer
Multiple Benefits
The evolution of the internet and related online technologies
has led to a growing emphasis on online education. This form
of learning is especially valuable to students who juggle
family and other responsibilities and who require access to
innovative forms of learning. By facilitating different forms
of interactivity, the Internet became a game changer with
regard to imparting education. Online courses and institutions
are investing effort into building a competitive workforce in
the UK by empowering students with the necessary knowledge and
skills required for a successful career.
With the government confirming that they are no longer able to
subsidise university and college education to the extent that
they did in earlier years, the overall costs of a formal
college education have escalated significantly over time.
Administrative, educational, manpower and technological costs
have added to the financial pressures of studying at
universities and colleges. There are other problems and
complexities involved. For example, if you happen to be a
mother of young children or toddlers, it may not be a viable
solution to have to commute daily to attend classes, take

exams and so on. Moreover, with busy classrooms, competitive
learning environments and course shortages, you may not always
be able to study the course that you really want.
Online education is the most important revolution that has
transformed the face of contemporary education. It has helped
create thousands of opportunities for all those who are
genuinely interested in learning something.

Let’s explore the benefits of doing
online courses:
Added flexibility:
Online education provides added flexibility, but not at the
cost of rigour or practice. Online courses are not easier or
harder than traditional courses, they are simply delivered
differently. You can plan your study around your free time
instead of the other way around. For busy mothers with
children, added flexibility is a crucial benefit because they
are in control of their times and schedules. You can schedule
your study time at nights or in the early mornings. Regardless
of the time, study material will always be available online
and this helps you balance your family and work commitments.
If you’ve had a sleepless night tending to your baby, you
don’t have to be nervous about running bleary-eyed to class
early the next morning.

Improved opportunities to concentrate:
Classroom learning environments can be a source of distraction
for students. Every individual is unique and for reticent or
shy people, online learning may represent the perfect
opportunity to learn in their own space. Not everyone is
comfortable with direct, physical classroom interaction and
many prefer the improved opportunities for concentration that

online courses offer. Online course students are happily
exempt from distracting conversations, whispering, mobile
phone beeps and relationship complexities that one invariably
encounters during classroom learning. You can interact at the
level that you are comfortable with.

Comfort:
Sitting for hours in a hard-backed chair can be extremely
harsh on the back and legs, especially if you have been busy
with household chores and children all day. If you opt to
study online, you can study comfortably by seating yourself on
a couch or a chair of your choice and even putting up your
feet, if you like. While comfort is a strong advantage,
perhaps it would be better not to get too comfortable either.
You may wish to create an inspirational space for studying in
your home consisting of a large table and chair.
When you enrol in an online course, you enjoy much more
control over your study environment. You can reduce the TV
volume or keep music playing softly in the background. In
addition, you can control heating or air conditioning to
comfortable levels. You can decide what works best for you.

Self-paced learning:
Self-paced learning implies learning at your pace and this is
a crucial benefit of online learning. Everyone learns
differently and when you learn at your own pace, it becomes
easier to attain your learning objectives. In a typical
classroom environment, the group of students consists of
individuals with different learning abilities. According to
research, teachers typically address the middle third and
learners who do not belong to this group, or who learn at a
different pace are usually lost or simply bored. Fast learners
have the opportunity to gain competencies at a rapid speed
while slower learners are not forced to forge ahead at an
uncomfortable pace. You can always go back to portions or

chapters that you found challenging and you can repeat this as
many times as you need to.
Moreover, self-paced learning allows you to concentrate at
your convenience. Some students study best during mornings
while others prefer evenings or nights when the house is
quiet. As a mother, you may be faced with unpredictable
schedules during the day, especially if you are caring for
babies or toddlers. Self-pacing allows you to weave in the
learning process around your other priorities. Your learning
becomes more personal and effective because you are able to do
it in the way that works best for your requirement. Most
online courses offer the option of learning at your pace as
well as interactive learning. This way, you need not feel
stressed about forcing the pace and struggling to understand
difficult portions. Moreover, you can also choose to study
full-time or part-time as your time and schedule permits.
Please note that students are expected to take exams, tests
and assessments and complete assignments in order to earn
online certification – just as you would if you attended
conventional college courses. The only difference is that you
gain the opportunity to learn in a way that helps you meet the
course objectives in a more effective manner. Online courses
have the potential to offer a customised learning experience.

Range of courses to choose from:
The field of online education has evolved and offers a wide
range of choice to students. You can earn certification in any
subject you can think of, giving you the opportunity to gain
knowledge in your chosen career.

Lower costs:
Cost is a major point of difference between face-to-face
education and online learning. However, it must be noted that
the costs of online education are not lower due to lower

quality of learning. The underlying objective of traditional
and online courses is the same: Imparting learning experiences
to students. On the contrary, you can save on costs because
other incidental expenses are lower when you opt to do an
online course. The following points illustrate why online
learning is a more economic option:
By studying from home, you do not have to pay for
apartment or residence fees and meals etc on the campus.
Commuting expenses are literally non-existent as you do
not need to spend on petrol, parking fees and vehicle
maintenance.
Even the simple process of applying to different
traditional colleges can prove to be expensive because
students often have to pay for the prospectus and
processing fees, etc. Comparing online courses is a
relatively cheaper option.
Online education usually does not involve bricks-andmortar premises and regular tuition fees. Although the
course fee will include interactive assistance from
tutors, students are not obliged to pay a regular
tuition fee.
With living costs rising every year, most interested students
may have felt discouraged due to multiple factors including
high costs of learning. E-learning has helped open many doors
to the world of education and careers.

Career advancement:
Online learning provides the opportunity to complete courses
and earn accredited certifications while raising your family
at the same time. You do not have to juggle impossible commute
schedules and desperately hunt for babysitters while you rush
to college. The customised learning experience helps ease the
burden of handling multiple responsibilities at once. You are
able to proactively work towards enhancing your skill set or
adding to your knowledge. The comprehensive study course will

help bridge any gaps in your CV or work experience and give
you the necessary knowledge to embark on a new career. In
addition, the decision to study indicates that you are serious
and ambitious about your career. Prospective employers are
more likely to perceive you as a suitable candidate.

General improvement in computer skills:
Regardless of the course that you enrol on, you can expect
your computer skills to become more proficient. Online study
courses typically involve undertaking assignments and tasks,
completing tests, watching videos, etc that will help you
improve your ability to work on a computer. Learning to
navigate the Internet for information helps you acquire real
time skills that open up several possibilities in your
professional career choices.

Individual attention:
Students opting for online courses often receive individual
attention from the tutor or instructor, and they also have the
option of receiving assistance by email. It’s common to find
students reticent to ask questions or clear their doubts in a
physical classroom for the fear of appearing ignorant.
Learning opportunities online are enhanced because you have
the freedom to ask questions in your own time. For example,
you may wish to clear some doubts after you have finished
studying a module. Unlike conventional study courses, you do
not have to remember your doubts or make special time to speak
to the tutor. This helps improve the quality of learning.

Online
learning
discipline:

inculcates

self-

Online study requires self-motivation and discipline because
you are responsible for your progress and performance. As you
work on your assignments and study for tests, you learn to

work on schedule, prioritise your goals and minimise
procrastination. These habits will invariably stand you in
good stead when you go to work or start your own business. You
learn the importance of self-responsibility and accountability
and this helps improve maturity and diligence. As you progress
and complete the course, you learn to become efficient and
self-motivated.
Although online education is a popular learning modality in
the UK, there are still come common misconceptions and doubts
associated with it. We discuss some important myths regarding
online education and explain the actual facts.
Rigour and quality of assessment: Online learning is as
rigorous and comprehensive as traditional learning
courses offered by colleges. Online courses offer
content, course materials, practice questions, tests,
homework assignments and assessments that are designed
to help the student attain his or her learning
objectives. Online courses are neither easier nor more
difficult than conventional courses.
Employer acceptance and recognition: Several colleges
and universities offer online as well as offline courses
to students and they make no distinction between the two
when conferring certificates or degrees. Similarly,
employers now accept online learning and certification
and respect students who have chosen to complete online
study programmes. Online study courses and certificates
are just as credible and authentic as traditional ones.
Online learning is here to stay: As technological
advances continue to evolve, online learning will
continue to grow and thrive as the outreach improves. A
growing number of courses will be offered online and
students will enjoy a comprehensive range of options to
choose from.
Online courses are as effective as traditional ones:
Online courses offer the same quality of learning,

materials and knowledge as conventional courses. The
only difference is the medium of delivery. Every course
is carefully designed to suit student requirements and
is updated as required. Quality control is an ongoing
process. In fact, research into study patterns indicate
that online courses encourage a higher rate of
retention.
Online study provides social interaction: The student
can choose the level of interaction with the instructor
as well as with other students. Interaction can be
facilitated using several methods such as Skype, Google
Hangouts and so on. You have the option of interacting
at the level that you want.
Online courses offer certifications at different levels:
According to popular belief, online courses may confer
certification but not full degrees. This, in fact, is a
myth and you can actually work towards different levels
and obtain a full-fledged degree. Many well-known
universities offer fully accredited degrees to online
students.
Online study involves deadlines and dates: Yet another
common misconception is that online courses tend to be
lax with regard to submission of assignments, etc.
Nothing could be further from the truth. As a student,
you are expected to turn in assignments or assessments
in accordance with dates and deadlines. While online
courses may offer flexibility with respect to time and
pace, they require the same level of dedication and hard
work as traditional courses.
It’s not easier to cheat on your tests or assessments:
Online students answer assessments that are protected by
tools and technologies. These tools can prevent cheating
on tests and assignments. The opportunities for cheating
are comparable to traditional courses – it’s very
similar. Online students do not have extra opportunities
to cheat.
Online assistance and guidance is offered by qualified

instructors and teachers: Teachers and instructors who
teach online courses are qualified and experienced and
they are subject to the same process of evaluation as
traditional face-to-face teachers. Online teachers often
spend more time in engaging students.
It’s not necessary to be technologically savvy in order
to study online: Online courses are designed to meet the
needs of students at different levels of technological
advancement. If students have problems, there is usually
a support number or email that you can use to obtain
assistance.
Embarking on a new career as a student or returning to work
after having children can be a daunting challenge. It’s
important to adopt an approach that factors in
responsibilities and constraints along with your career
objectives. The process of returning to work or starting your
own business involves building your confidence, acquiring new
skills or upgrading a skill set and rediscovering your career
path and personal interests. Online learning helps you develop
important life skills, including self-discipline and
motivation. In addition to juggling study, work and family
life, you get the unique opportunity to learn at your pace in
your time.
In a world where the only constant is change, online education
helps with the acquisition of knowledge and development of
skills. In the thriving British economy, employers are always
keen to secure professional talent. If you are not interested
in working for an employer, online education can also equip
you with the skills required to jumpstart a freelance career.
In a competitive and time-strapped work environment, online
education and courses provide prospective students with
important tools to add value to their current skill set.
Moreover, you are able to improve your skill set without being
obliged to compromise with time and space constraints.
Studying an up-to-date online course helps you understand and

keep abreast of the latest developments in your chosen field
of interest. Past employers and companies may now have
different requirements compared to what they were before you
took your sabbatical from work. In such cases, you may find
that you need to enhance your skill set in order to enjoy
flexible options with respect to your job. Online courses
provide you with the right support system and build your
confidence as you prepare to embark on an exciting and
fulfilling career path. The right online learning
opportunities coupled with an empowering mindset can go a long
way in helping you chart success in the second career innings
and realise your dreams.

